COMPUTER CAPSULE
Dear Readers,
We are presenting you the Computer Capsule. As per our commitments towards the needs of every student,
this capsule contains all the important facts and details that can be asked in the Upcoming Exams IBPS Exams. We
are starting this with the introduction of the Syllabus. Let us begin now :
Syllabus of The Computer Section
1. Fundamentals of the Computer :
i) Hardware and Software
ii) Memory and Memory Units
iii) Number System
2. Internet
3. Microsoft Office (MS-Office)
4. Networking
5. DBMS (Database Management System)
6. Programming Languages
7. Full Forms/Abbreviations and Important Terms
8. Shortcut Keys
9. Miscellaneous (Latest in Computers and Mobile Technology)
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COMPUTER FUNDAMENTALS
 A Computer is a general purpose device that can be
programmed to carry out a set of arithmetic or
logical operations automatically. Since a sequence
of operations can be readily changed, the computer
can solve more than one kind of problem.
 A general purpose computer has four main
components: the arithmetic logic unit (ALU), the
control unit, the memory, and the input and output
devices (collectively termed I/O).
 The data that is fed into a computer processor
received into the computer by a keyboard or other
sources is called Input.
 A computer is an electronic device that accepts data
from the user (input), processes the data by
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performing calculations and operations on it and
generates the desired Output.
The device which is used with a computer to display
or store data is called Peripherals.
The mechanical, magnetic, electronic and electrical
components that comprises a computer system
such as the Central Processing Unit (CPU), monitor,
keyboard, etc. is known as Hardware.
A set of instructions that tells the computer about
the tasks to be performed and how these tasks are
to performed, is known as Software.
An unprocessed collection or representation of raw
facts represented in a manner suitable for
communication, interpretation or processing by
humans or by automatic means, is known as Data.
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 The result of processing, manipulating and
organising data in a way that adds to the knowledge
of the person receiving it, is known as Information.
 The smallest unit of information, a computer can
understand and process, is known as Bit.
 The primary goal of computer is to process
information that it receives and output the results.
The process of control and alter information is
known as Processing.
 The number system computer used to store data and
perform calculation - Binary Number System.
 Computer Speed, Accuracy, Diligence, Storage
Capability, Automation, Remembrance Power and
Versatility are the main Characteristics of
Computer.
 Self Intelligence, Decision-Making power, Learning
power, Self care, Feelings are the Limitations of
Computer.
 A mainframe computer is a much larger computer
that typically fills a room and may cost many
hundreds or thousands of times as much as a
personal computer. They are designed to perform
large numbers of calculations for governments and
large enterprises.
 Read-only memory (ROM) is a storage medium
used in computers and other electronic devices. Data
stored in ROM can only be modified slowly or with
difficulty, or not at all.
 ROM is non-volatile and the contents are retained
even after the power is switched off.
 It only allows reading.
 The types of ROM include PROM, EPROM and
EEPROM.
 Random Access Memory (RAM),allows the
computer to store data for immediate for immediate
manipulation and to keep track of what is currently
being processed.
 RAM is referred to as volatile memory and is lost
when the power is turned off.
 It allows reading and writing.
 The two main types of RAM are static RAM and
dynamic RAM.
 SRAM retains data as long as power is provided to
the memory chip and need not be refreshed
periodically. SRAM stands for Static Random Access
Memory.

 Primary memory is computer memory that a
processor or computer accesses first or directly.
 For example: RAM, and Cache Memory.
 Secondary memory (or secondary storage) is the
slowest and cheapest form of memory. It cannot be
processed directly by the CPU.
 Secondary memory devices include magnetic disks
like hard drives and floppy disks, optical disks such
as CDs and CDROMs, and magnetic tapes, which were
the first forms of secondary memory.
 Virtual memory is memory on the hard disk that
the CPU uses as an extended RAM.
 Installation is the process of copying software
programs from secondary storage media to the hard
disk.
 A central computer that holds collections of data and
programs for many PCs, workstations and other
computers is a Server.

 The data on DRAM continues to move in and out of
the memory as long as power is available and must
be continually refreshed to maintain the data. DRAM
stands for Dynamic Random Access Memory.
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 An Arithmetic Logic Unit (ALU) is a digital circuit

that performs integer arithmetic and logical
operations. The ALU is a fundamental building block
of the central processing unit of a computer.

 Control Unit is responsible for controlling the
overall operations of computer. It coordinates the
sequence of execution of instructions and controls
the overall functioning of the computer.
 The first computer architecture was introduced by
John Von Neumann (1970)
 Personal computers use a number of chips mounted

on a main circuit board called Motherboard.
 The CPU is fabricated as a single Integrated Circuit
(IC) chip. It is also known as the Microprocessor.

 Multiprocessing is the use of two or more central
processing units (CPUs) within a single computer
system. The term also refers to the ability of a system

to support more than one processor and/or the
ability to allocate tasks between them.

 The organization and interconnection of the various
components of a computer system is known as

Computer Architecture.
 A CPU can directly understand the Machine
Language.
 An input device is any peripheral (piece of

computer hardware equipment) used to provide
data and control signals to a computer. They are the

devices that feed data into a computer.
 Examples of input devices include keyboards, mouse,
scanners, digital cameras and joysticks.
 The keys include the letter keys (0, 1, 2, ..., 9; A, B, Z),

which are generally laid out in the same style as in
typewriters are known as Alphanumeric Keys.
 'Caps lock' and 'Num lock' keys are called as Toggle

Keys because when pressed, they change their status
from one state to another.
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Numeric Keypad is a keypad located on the right
hand side of the keyboard. It consists of digits and
mathematical operators.
A Modifier key is a special key (or combination) on
a computer keyboard that temporarily modifies the
normal action of another key when pressed together.
By themselves, modifier keys usually do nothing;
that is, pressing any of the Shift, Alt, or Ctrl keys
alone does not (generally) trigger any action from
the computer.
A Mouse is the most popular input device which is
used today for interactive processing and for the one
line entry of data for batch processing.
Drag and Drop refers to the action of clicking and
holding down the mouse button, while moving the
mouse and then releasing the mouse button.
The first computer mouse was invented by Douglas
Engelbart.
Joystick is the device that moves in all directions
and controls the movement of a pointer.
A Touch Screen is a type of display screen device
that is placed on the computer monitor to allow
direct selection or activation of the computer when
the user touches the screen.
Light Pen is the pen shaped device, which can sense
light and is used to point at spots on a video screen.
A technology enables a high-speed reading of large
quantities of data and transferring these data to the
computer without using a keyboard. It is referred as
Optical Mark Reader (OMR).
It uses a beam of light that is reflected on the paper
with marks, to capture presence and absence of
marks.
MICR reads the characters by examining their shapes
in a matrix form and the information is then passed
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`on to the computer. MICR stands for Magnetic Ink
Character Reader.
It provides a high level of security and is therefore
used by the banking industry for faster processing of
the cheques
It is a machine readable code, which is represented
by parallel vertical lines with varying widths. For
reading these bar-coded data, a device is used, which
is known as a Bar Code Reader (BCR)
Optical Character Recognition (OCR) is used to
scan the document containing text.
It is the mechanical or electronic conversion of
scanned or photographed images of typewritten or
printed text into machine-encoded/computerreadable text.

 Impact printers create an image by using some
mechanism to physically press an inked ribbon
against the page, causing the ink to be deposited on
the page in the shape desired.
 Examples of Impact Printers are Character
Printers and Dot Matrix Printers.
 Non – Impact Printers do not touch the paper when
creating an image.
 Examples of Non - Impact Printers are Inkjet
printers, Laser printers, Solid ink printers, Dyesublimation, Thermal wax printers, Thermal auto
chrome printers.
 A pen based output device, attached to a computer
for making vector graphics, that is, images created by
a series of many straight lines is known as Plotters.
 The number of pixels displayed on a screen is known
as Resolution.
 A Monitor is a TV-like display attached to the
computer on which the output can be displayed and
viewed. It can either be a monochrome display or a
colour display.
 The set of instructions, which control the sequence
of operations, are known as Program. Itis a
sequence of instructions, written to perform a
specified task with a computer.
 A Software instructs the computer what to do and
how to do it. It is a set of instructions that tells the
computer about the tasks to be performed and how
these tasks are to performed.
 One or more defects or problems that prevent the
software from working as intended of working at all
are called Bug.
 Software that contributes to the control and
performance of the computer system and permits
the user to use the system more conveniently is
termed as System Software.
 Antivirus Software is used to scan the hard disk to
remove the virus from them.
 The assembly language program is translated into
machine code by a separate program known as an
Assembler.
 A Backup, or the process of backing up, refers to the
copying and archiving of computer data so it may be
used to restore the original after a data loss event. It
contains a copy of every program data and system
file on a computer.
 An Operating System controls the way in which the
computer system functions and provides a means by
which users can interact with the computer.
 Loading of the Operating System is known as
Booting. Restarting a computerthat is already on, is
referred to as Warm Booting.
 Basic Input – Output System (BIOS) is the part of
operating system that manages the essential

 A keyboard is a typewriter-style device, which uses
an arrangement of buttons or keys, to act as
mechanical levers or electronic switches.
 Most of the commonly available personal computers
have a keyboard, popularly known as Qwerty.
 The keys labeled Fl to F12 on the keyboard are called
Function Keys.
 An output device is any piece of computer hardware
equipment used to communicate the results of data
processing carried out by an information processing
system (such as a computer) which converts the
electronically generated information into humanreadable form
 The printed form of output is referred as Hard Copy.
 The form of output displayed on the screen is
referred as Soft Copy.
 The device that prints information from the
computer onto the paper is Printer.
 Pages Per Minute (PPM) is the unit used to count
the speed of the printer.
 On the basis of technology, printers are categorized
into Impact and Non- Impact Printers.
www.bankersadda.com
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peripherals such as the keyboard, screen, disk drives
and parallel and serial ports.
An Integrated Software is a single application that
combines major features of several types of
application.
An Application Software is the program that makes
the computer useful to the users.
Computer hardware is the collection of physical
elements that constitutes a computer system.
Computer hardware refers to the physical parts or
components of a computer such as the monitor,
mouse, keyboard, computer data storage, hard drive
disk (HDD), system unit (graphic cards, sound cards,



Memory Units:

4 bit
8 bit
1024 B
1024 KB
1024 MB
1024 GB
1024 TB
1024 PB
1024 XB
1024 ZB

1 nibble
1 byte
1 KB (Kilo Byte)
1 MB (Mega Byte)
1 GB (Giga Byte)
1 TB (Tera Byte)
1 PB (Peta Byte)
1 XB (Exa Byte)
1 ZB (Zeta Byte)
1 YB (Yota Byte)

 bit (b)
 Byte (B)
 The number system, the modern computers are
operated - Binary Number System(0's and 1's)
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memory, motherboard and chips), etc. all of which
are physical objects that can be touched.
 The motherboard is the main component of
computer. It is a large rectangular board with
integrated circuitry that connects the other parts of
the computer including the CPU, the RAM, the disk
drives(CD, DVD, hard disk, or any others) as well as
any peripherals connected via the ports or the
expansion slots.

 Name the most significant bit, which represent 1
and 0 for a positive number and negative number,
respectively - Sign Bit
 Which coding scheme represents data in a binary
form in the computer system? ASCII, EBCDIC and
Unicode are the most commonly used codes under
this scheme - Binary Coding Scheme
 EBCDIC is a 8-Bit code with 256 different
representations of characters. It is mainly used in
mainframe computers.
 EBCDIC stands for - Extended Binary Coded
Decimal Interchange Code
 BCD is a method that represents the decimal digits
with the help of binary digits. It takes advantage
that one decimal numeral can be represented by 4bit pattern. BCD stands for Binary Coded Decimal
 This coding system is used to represent the interval
storage area of the computers. In this system, every
character is represented by a combination of bits.
Binary Coding System
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 The Base or Radix of the decimal number system is
10
 The standard code the computer industry created to
represent characters - American Standard Code
for Information Interchange (ASCII)
ASCII is a code used for standardizing the
storage and transfer of information amongst
various computing devices.
 It is required for representing more than 64
characters. At present, the mostly used coding
systems are ASCII and EBCDIC
 The code is also known as Reflected Code - Gray
Code

Number System
Decimal, Binary, Octal and Hexadecimal Equivalents
Decimal
Binary
Octal
Hexadecimal
0
0000
000
0
1
0001
001
1
2
0010
002
2
3
0011
003
3
4
0100
004
4
5
0101
005
5
6
0110
006
6
7
0111
007
7
8
1000
010
8
9
1001
011
9
10
1010
012
A
11
1011
013
B
12
1100
014
C
13
1101
015
D
14
1110
016
E
15
1111
017
F

 A Cursor is an indicator used to show the position
on a computer monitor or other display device that
will respond to input from a text input or pointing
device.
Basic Keys (Common Tasks)
Ctrl + Shift +
Create a non breaking space
Spacebar
Ctrl + B
Make letters bold
Ctrl + I
Make letters italic
Ctrl + U
Make letters underline
Ctrl + Shift+ < Decrease font size one value
Ctrl + Shift + > Increase the font size one value
Ctrl + [
Increase the font size by 1 point
Ctrl + ]
Decrease the font size by 1 point
Ctrl +
Remove paragraph or character
Spacebar
formatting.
Ctrl + C
Copy the selected text or object
Ctrl + X
Cut the selected text or object
Ctrl + V
Paste text or an object
Ctrl + Alt + V
Paste special
Ctrl + Shift + V Paste formatting only
Ctrl + Z
Undo the last action
Ctrl + Y
Redo the last action

MICROSOFT OFFICE
 Microsoft Office is an office suite of desktop
applications, servers and services for the Microsoft
Windows and OS X operating systems. It was first
announced by Bill Gates of Microsoft on August 1,
1988 at COMDEX in Las Vegas.
 MS office primarily includes Word, Excel,
PowerPoint, Access and Outlook. It also includes
OneNote, Groove, InfoPath and Publisher.
MS WORD
 Microsoft Word is a word processor developed by
Microsoft.
 It is used for creating, editing, formatting, storing,
retrieving and printing of a text document.
 Microsoft Word's native file formats are denoted
either by a .doc or .docx file extension.

www.bankersadda.com

|

 To create a document, we use New command at the
menu.
 Save as is used to save a document for the first
time. It is also used to change the destination of the
saved file in the computer.
 Print Preview is used to see the document before
the printout is taken.
 Cut and Paste options are used to move the data
from one part of the document to another.
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Control Keys + Function keys
Ctrl+F2
Ctrl+F3

Choose
the
print
preview
command (Microsoft office Button)
Cut on the spike

Ctrl+F4

Close the window

Ctrl+F6

Go to the next window

Ctrl+F9

Insert an empty field

Ctrl+F10

Maximise the document window

Ctrl+F11

Lock a field



Ctrl+F12

Choose the
Open command
(Microsoft Office Button)



F1
F2
F4
F5
F6
F7
F8
F9
F10
F11
F12









 Portrait and Landscape options are available
in Orientation category of Page Setup.
 Alignment refers to the position of text
between the margins.
 Auto complete is a feature in word that
automatically completes the spelling of days of
the week and months of the year that have
more than five letters in their names.





Function Keys
Get help or visit Microsoft office Online.
Move text or graphic.
Repeat the last action
Choose the Go To command (Home tab).
Go to the nest pane or frame.
Choose the spelling command (Review
tab)
Extend a selection
Update the selected fields
Show key tips
Go to the nest field
Choose the Save As command
(Microsoft Office Button).












Word has extensive lists of bullets and
numbering features used for tables, lists, pages,
chapters, headers, footnotes, and tables of content.
MS EXCEL
Microsoft Excel is a spreadsheet application
developed by Microsoft for Microsoft Windows
and Mac OS.
It features calculation, graphing tools, pivot tables,
and a macro programming language called Visual
Basic for Applications.
The intersection of a row and column is called a
Cell.
The cell in which we are currently working is
known as Active Cell.
Microsoft Excel's native file formats are denoted
either by a .xls or .xlsx file extension.
A Worksheet is made of columns and rows,
wherein columns run Vertically and rows run
Horizontally.
Up to Excel 2003, the standard amount of columns
has been 256 and 65,536 rows.
Excel 2007 onwards, the maximum number of
rows per worksheet increased to 1,048,576 and
the number of columns increased to 16,384.
Microsoft Excel has the basic features of all
spreadsheets, using a grid of cells arranged in
numbered rows and letter-named columns to
organize data manipulations like arithmetic
operations
The letter and number of the intersecting column
and row is the Cell Address.
Short cut key to insert a new worksheet in MSExcel is ALT + Shift + F1 + or F11.
Sheet tab is the tab at the bottom of the worksheet
window that displays the name of the worksheet.
A Microsoft office document that contains one or
more worksheets is known as a Workbook.

Header and Footer option is used to display
information such as title and page number of the
document.
The bar at the top of the window that bears the
name of the window, is known as Title Bar.
A screen element of MS Word that is usually
located below the title bar that provides
categorisedoption, is called Menu Bar.
Auto Correct in word automatically corrects
certain spelling, typing, capitalisation or grammar
errors.
Thesaurus is used for finding a synonym for a
word in the document.
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Shortcut Keys of MS-Excel
Key
Description
F2
Edit the selected cell
F5
Go to a specific cell
F7
Spell check selected text and/or
document
F11
Create chart
Ctrl + Shift + ; Enter the current time
Ctrl + ;
Enter the current date
Shift + F3
Open the Excel formula window
Shift + F5
Bring up search box.
Ctrl + A
Select all contents of the worksheet
Ctrl + B
Bold highlighted selection
Ctrl + I
Italic highlighted selection
Ctrl + U
Underline highlighted selection
Ctrl + P
Bring up the print dialog box to
begin printing
Ctrl + Z
Undo last action
Ctrl + F9
Minimise current workbook
Ctrl + F10
Maximise currently selected
workbook
Ctrl + F6
Switch between open
workbooks/window
Ctrl + page up Move between Excel worksheet in
the same Excel document.
Ctrl + Page
Move between Excel worksheets in
Down
the same Excel document
Ctrl + Tab
Move between two or more open
Excel files
Alt + =
Create a formula to sum all of the
above cells
Ctrl + ’
Insert the value of the above cell
into cell currently selected.
Ctrl + Arrow
Move to next section to text
key
Ctrl + Space
Select entire column
Shift +
Select entire row
Space

Important Questions Based on Microsoft
Word:
1. Pressing F8 key for three times selects
A) A word
B) A sentence
C) A paragraph
D) Entire document

3. How can you disable extended selection mode?
A) Press F8 again to disable
B) Press Del to disable
C) Press Esc to disable
D) Press Enter to disable
4. What does EXT indicator on status bar of MS
Word indicate?
A) It indicates whether the external text is pasted on
document or not
B) It indicates whether extended add-ons are
installed on MS Word or not
C) It indicates whether Extended Selection mode is
turned on or off
D) None of above
5. What is the maximum number of lines you can
set for a drop cap?
A) 3
B) 10
C) 15 D) 20
6. What is the default number of lines to drop for
drop cap?
A) 3
B) 10
C) 15 D) 20
7. What is the shortcut key you can press to
create a copyright symbol?
A) Alt+Ctrl+C
B) Alt + C
C) Ctrl + C
D) Ctrl + Shift + C
8. How many columns can you insert in a word
document in maximum?
A) 35
B) 45
C) 55 D) 65
9. What is the smallest and largest font size
available in Font Size tool on formatting toolbar?
A) 8 and 72
B) 8 and 64
C) 12 and 72
D) None of above
10. What is the maximum font size you can apply
for any character?
A) 163
B) 1638
C) 16038
D) None of above
11. Which of the following is graphics solution for
Word Processors?
A) Clipart
B) WordArt
C) Drop Cap
D) All of above

2. What happens if you press Ctrl + Shift + F8?
A) It activates extended selection
B) It activates the rectangular selection
C) It selects the paragraph on which the insertion line
12. The keystrokes Ctrl + I is used to
is.
A) Increase font size
D) None of above
B) Inserts a line break
www.bankersadda.com
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C) Indicate the text should be bold
D) Applies italic format to selected text
13. A character that is raised and smaller above
the baseline is known as
A) Outlined
B) Raised
C) Superscript
D) Subscript
14. What is the purpose of inserting header and
footer in document?
A) To enhance the overall appearance of the
document
B) To mark the starting and ending of page
C) To make large document more readable
D) To allow page headers and footers appear on
document when printed
15. Which of the following function key activates
the speller?
A) F5
B) F7
C) F9
D) Shift + F7

B) Do a computer search in media center
C) Maintain an inventory
D) Type a biography
21. Which of the following is not valid version of
MS Office?
A) Office XP
B) Office Vista
C) Office 2007
D) None of above
22. You cannot close MS Word application by
A) Choosing File menu then Exit submenu
B) Press Alt+F4
C) Click X button on title bar
D) From File menu choose Close submenu
23. The key F12 opens a
A) Save As dialog box B) Open dialog box
C) Save dialog box
D) Close dialog box

16. The minimum number of rows and columns in
MS Word document is
A) 1 and 1
B) 2 and 1
C) 2 and 2
D) None of above
17. Thesaurus tool in MS Word is used for
A) Spelling suggestions
B) Grammar options
C) Synonyms and Antonyms words
D) All of above
18. Why Drop Caps are used in document?
A) To drop all the capital letters
B) To automatically begin each paragraph with
capital letter
C) To begin a paragraph with a large dropped initial
capital letter
D) None of above
19. A bookmark is an item or location in
document that you identify as a name for future
reference. Which of the following task is
accomplished by using bookmarks?
A) To add anchors in web page
B) To mark the ending of a paragraph of document
C) To quickly jump to specific location in document
D) To add hyperlinks in webpage

24. What is the short cut key to open the Open
dialog box?
A) F12
B) Shift F12
C) Alt + F12
D) Ctrl + F12
25. A feature of MS Word that saves the document
automatically after certain interval is available
on
A) Save tab on Options dialog box
B) Save As dialog box
C) Both of above
D) None of above
26. Where can you find the horizontal split bar on
MS Word screen?
A) On the left of horizontal scroll bar
B) On the right of horizontal scroll bar
C) On the top of vertical scroll bar

20. A word processor would most likely be used
to do
A) Keep an account of money spent
www.bankersadda.com
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D) On the bottom of vertical scroll bar
27. Which of the following is not available on the
Ruler of MS Word screen?
A) Tab stop box
B) Left Indent
C) Right Indent
D) Center Indent
E) All of them are available on ruler
28. What is place to the left of horizontal scroll
bar?
A) Tab stop buttons B) View buttons
C) Split buttons
D) Indicators
E) None of above
29. Which file starts MS Word?
A) Winword.exe
B) Word.exe
C) Msword.exe
D) Word2003.exe
30. How many ways you can save a document?
A) 3
B) 4
C) 5
D) 6
31. If you want to keep track of different editions
of a document which features will you use?
A) Editions
B) Versions
C) Track Change
D) All of above
32. Background color or effects applied on a
document is not visible in
A) Web layout view
B) Print Layout view
C) Reading View
D) Print Preview
33. What is a portion of a document in which you
set certain page formatting options?
A) Page
B) Document
C) Section
D) Page Setup

B) Margin that is added to right margin when
printing
C) Margin that is added to the binding side of page
when printing
D) Margin that is added to the outside of the page
when printing
38. Portrait and Landscape are
A) Page Orientation
B) Paper Size
C) Page Layout
D) All of above
39. If you need to change the typeface of a
document, which menu will you choose?
A) Edit
B) View
C) Format
D) Tools
40. Which of the following is not a font style?
A) Bold
B) Italics
C) Regular
D) Superscript

41. What happens when you click on Insert >>
Picture >> Clip Art
A) It inserts a clipart picture into document
B) It lets you choose clipart to insert into document
C) It opens Clip Art taskbar
D) None of above
42. Which option is not available in Insert Table
Auto fit behavior?
A) Fixed Column Width
B) AutoFit to Contents
C) Autofit to Window
D) Autofit to Column

34. Borders can be applied to
A) Cells
B) Paragraph
C) Text
D) All of above

43. To autofit the width of column
A) Double click the right border of column
B) Double click the left border of column
C) Double click the column header
D) All of above

35. Which of the following is not a type of page
margin?
A) Left
B) Right
C) Center
D) Top

44. From which menu you can insert Header and
Footer?
A) Insert Menu
B) View Menu
C) Format menu
D) Tools Menu

36. What is the default left margin in Word 2003
document?
A) 1"
B) 1.25"
C) 1.5" D) 2"

45. After typing header text, how can you quickly
enter footer text?
A) Press PageDown key and type the text for footer
B) Click on Switch between Heder & Footer then type
the text
C) Both of above
D) None of above

37. What is gutter margin?
A) Margin that is added to the left margin when
printing
www.bankersadda.com
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46. When inserting Page number in footer it
appeared 1 but you wish to show a. How can you
do that?
A) From format menu choose bullets and Numbering
and configure necessary setting
B) From Insert menu choose Page Number and
specify necessary setting
C) Click on Page Number Format tool and specify
required setting
D) All of above
47. Which of the following statement is false?
A) You can set different header footer for even and
odd pages
B) You can set different page number formats for
different sections
C) You can set different header footer for first page of
a section
D) You can set different header and footer for last page
of a section
48. Where can you change the vertical alignment?
A) Formatting toolbar
B) Paragraph dialog box
C) Page Setup dialog box
D) Standard toolbar
49. To get to the ‘Symbol’ dialog box, click on the
______ menu and choose ‘Symbol’.
A) Insert
B) Format
C) Tools
D) Table
50. Which of the following symbol sets would be
most likely to contain a mathematical symbol
such as a degree sign, greater than or equal to, or
a Greek letter?
A) Wingdings
B) Wingdings 3
C) Webdings
D) Symbol
51. When assigning a shortcut key to a symbol,
you should always try to select a key or key
combination that is:
A) unassigned
B) Located on the ten-key pad section of your
keyboard.
C) Assigned to another task.
D) From the same font family as the symbol.
52. Suppose you wanted to create an AutoCorrect
entry that would type the words ‘We regret to
inform you that your submission has been
www.bankersadda.com
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declined’ Of the following choices, which would
be the best name you could assign to this entry?
A) Regret
B) Subdual
C) We regret to inform you that your submission has
been declined
D) 11
53. If you want to convert a symbol or several
lines of text into an AutoCorrect entry, you
should:
A) Insert the symbol or type the text in a Word
document first. Then, select the text or symbol and go
to the AutoCorrect dialog box.
B) Click the Tools menu and choose AutoCorrect
Options. Then, click the Insert menu and choose
Symbol (or click the Format menu and choose
Paragraph) to add the symbol or paragraph to
AutoCorrect.
C) AutoCorrect can only accommodate one line of
text. It is not possible to convert a symbol or multiple
lines of text into an AutoCorrect entry.
D) Insert the symbol or type the text in a Word
document first. Then, select the text or symbol and
click the Edit menu followed by Paste Special. Select
New AutoCorrect Entry and then click OK.
54. AutoCorrect was originally designed to
replace _________ words as you type.
A) Short, repetitive
B) Grammatically incorrect
C) Misspelled
D) None of the above
55. Which of the following is the second step in
creating a macro?
A) Start recording
B) Using your mouse or keyboard, perform the task
you want to automate
C) Assign a keyboard shortcut to the macro
D) Give the macro a name
56. If you will be displaying or printing your
document on another computer, you’ll want to
make sure and select the _____________ option under
the ‘Save’ tab.
A) Embed Fonts
B) Embed True Type Fonts
C) Save True Type Fonts D) Save Fonts
57. In Word, the mailing list is known as the
____________.
A) Data sheet
B) Source
C) Data source
D) Sheet
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58. Which of the following is not one of the three
‘Mail Merge Helper’ steps?
A) Merge the two files
B) Create the main document
C) Set the mailing list parameters
D) Create the data source
59. Which of the following button will allow you
to add, delete, or change records in your Data
Source?
A) ‘Data Source’ button
B) ‘Edit’ button
C) ‘Edit Data Source’ button
D) ‘Data editing’ button
60. It is possible to _______ a data source before
performing a merge.
A) Create
B) Modify
C) Sort
D) all of the above
61. What is the default font size of a new Word
document based on Normal template?
A) 10 pt
B) 12 pt
C) 14 pt
D) None of above
62. What is the default font used in MS Word
document?
A) Times New Roman
B) Arial
C) Algerian
D) Preeti
63. Which tab in Font dialog box contains options
to apply font effects?
A) Font tab
B) Character Spacing
C) Text Effects
D) Standard Toolbar
64. If you need to double underline a word, how
will you do that?
A) Go to Format menu and then Font option. Open
Underline Style and choose Double Underline
B) From Format menu choose Font option and then
from Font tab open Underline Style and select Double
Underline
C) Select the text then choose Format >> Font and on
Font tab open Underline Style and choose Double
Underline
D) Click double underline tool on formatting toolbar
65. DropCap means
A) All Caps
C) Title case

B) Small Caps
D) None of above

A) Ctrl + F
C) Ctrl + D

B) Alt + Ctrl + F
D) Ctrl + Shift + D

67. How can you access the font size tool on
formatting toolbar?
A) Ctrl + S
B) Ctrl + Shift + S
C) Ctrl + P
D) Ctrl + Shift + P
68. How can you make the selected character
superscripted?
A) Ctrl + =
B) Ctrl + Shift + =
C) Alt + Ctrl + Shift + =
D) None of above
69. What does Ctrl + = key effect?
A) Superscript
B) Subscript
C) All Caps
D) Shadow
70. What happens if you mark on Hidden check
box of Font dialog box after you select some text?
A) The text is deleted from document and you need to
bring from Recycle Bin if required again.
B) The text is hidden and you need to bring it by
removing the check box if needed again
C) The text is deleted and cannot be returned back
D) The text is hidden and cannot be returned back
71. How can you increase the font size of selected
text by one point every time?
A) By pressing Ctrl + ] B) By pressing Ctrl + [
C) By pressing Ctrl + } D) By pressing Ctrl + {
72. Which of the following line spacing is invalid?
A) Single
B) Double
C) Triple
D) Multiple

73. How can you apply exactly the same
formatting you did to another text?
A) Copy the text and paste in new location. Then type
the new text again.

66. What is the short cut key to open Font dialog
box?
www.bankersadda.com
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B) Copy the text and click on Paste Special tool on
new place
C) Select the text then click on Format Painter and
select the new text
D) All of above
74. What should you do if you require pasting the
same format in many places?
A) Click the Format painter and go on pasting in
many places holding Alt Key
B) Double click the format painter then go on pasting
in many places
C) Click the format painter then go on pasting to
many places holding Ctrl Key
D) All of above
75. On which toolbar can you find Format Painter
tool?
A) Standard toolbar B) Formatting toolbar
C) Drawing Toolbar D) Picture Toolbar
76. Which indent marker controls all the lines
except first line?
A) First Line Indent Marker
B) Left Indent Marker
C) Hanging Indent Marker
D) Right Indent Marker
77. How can you remove tab stop markers from
ruler?
A) Double click the tab marker and choose Clear All
B) Drag the tab stop marker out of the ruler
C) Right click the tab stop marker and choose remove
D) All of above
78. Which operation you will perform if you need
to move a block of text?
A) Copy and Paste
B) Cut and Paste
C) Paste and Delete
D) Paste and Cut
79. What is the extension of Word files?
A) FIL
B) DOT
C) DOC
D) TXT
80. Which of the following option is not available
in Insert >> Picture?
A) Chart
B) Word Art
C) Clip Art
D) Graph
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INTERNET

 The Internet is a global system of
interconnected computer networks that use the
standard Internet protocol suite (TCP/IP) to
link several billion devices worldwide.
 It is a network of networks that consists of
millions of private, public, academic, business,
and government networks, of local to global
scope, that are linked by a broad array of
electronic, wireless, and optical networking
technologies.
 The World Wide Web (abbreviated as WWW
or W3, commonly known as the Web) is a
system of interlinked hypertext documents that
are accessed via the Internet.
 A Website, is a set of related web pages served
from a single web domain.
 A Home page, index page, or main page is a
page on a website. A home page usually refers
to:
 The initial or main web page of a website,
sometimes called the "front page" (by analogy
with newspapers).
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The first page that appears upon opening a
web browser program, which is also
sometimes called the start page. This 'start
page' can be a website or it can be a page with
various browser functions such as the visual
display of websites that are often visited in
the web browser.
 The web page or local file that automatically
loads when a web browser starts or when the
browser's "home" button is pressed; this is
also called a "home page". The user can
specify the URL of the page to be loaded, or
alternatively choose e.g. to re-load the most
recent web page browsed.
 A personal web page, for example at a web
hosting service or a university web site, that
typically is stored in the home directory of the
user.
A Hyperlink is a reference to data that the reader
can directly follow either by clicking or by hovering
or that is followed automatically
A web browser (commonly referred to as a
browser) is a software application for retrieving,
presenting and traversing information resources on
the World Wide Web.
Some of the famous browsers are Safari, Chrome,
Firefox, Bolt, UC Browser and Internet Explorer
The Uniform Resource Locator, abbreviated as
URL is a specific character string that constitutes a
reference to a resource. In most web browsers, the
URL of a web page is displayed on top inside an
address bar.
(i) An example of a typical URL would be
"http://www.bankersadda.com".
Downloading means to receive data to a local
system from a remote system, or to initiate such a
data transfer
Uploading refers to the sending of data from a local
system to a remote system such as a server or
another client with the intent that the remote
system should store a copy of the data being
transferred
An Internet Protocol address (also known as an
IP address) is a numerical label assigned to each
device (e.g., computer, printer) participating in a
computer network. It acts as an identifier for a
computer. It is a unique address for every
computer.
An email attachment is a computer file sent along
with an email message. One or more files can be
attached to any email message, and be sent along
with it to the recipient.
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 Hotmail was co - founded by an Indian American
entrepreneur Sabeer Bhatia along with Jack Smith
in July of 1996
 CC(Carbon Copy) in e – mail indicates those who
are to receive a copy of a message addressed
primarily to another. The list of CCed recipients is
visible to all other recipients of the message.
 An additional BCC (blind carbon copy) field is
available for hidden notification; recipients listed in
the BCC field receive a copy of the message, but are
not shown on any other recipient's copy (including
other BCC recipients)
 The Drafts folder retains copies of messages that
you have started but are not yet ready to send.
 The first email was sent by Ray Tomlinson to
himself in 1971.

DATA COMMUNICATION & NETWORKING

 Data Communication deals with the transmission
of digital data from one device to another. Data is
transferred through a pathway called as
communication channel which can be physical wire
connecting the devices or may be unguided media
like laser, microwave etc.
 A communication channel has a source or
transmitter at one side and a designation or
receiver at another side of the network. The source
of data origination is single but there may be
multiple receivers. A communication channel is of 3
types:
 Simplex: In this, communication is unidirectional
i.e. one of the two devices can transmit the data
and the other can only receive the data. For eg.
Radio broadcasting, television broadcasting etc.
 Half
duplex:In
this
communication
is
bidirectional. Either of the devices can act as
transmitter or receiver but only one device can
transmit the data at one time. For eg. Walkie
talkie.
 Full Duplex: Here also communication is in both
directions and both the devices can
simultaneously transmit the data. For eg.
Telephone conversation.
 Different types of network are: LAN, MAN and
WAN.
 A LAN (local area network) is a group of computers
and network devices connected together, usually
within the same building. By definition, the
connections must be high speed and relatively
inexpensive (e.g., token ring or Ethernet).
 A MAN (metropolitan area network) is a larger
network that usually spans several buildings in the
same city or town.
 A WAN (wide area network), in comparison to a
MAN, is not restricted to a geographical location,
www.careerpower.in
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although it might be confined within the bounds of a
state or country. A WAN connects several LANs, and
may be limited to an enterprise (a corporation or an
organization) or accessible to the public. The
technology is high speed and relatively expensive.
The Internet is an example of a worldwide public
WAN.

 bridge thus improving performance. It uses physical
addresses of the packets for this decision. It works
on Data Link Layer of the OSI model. A bridge uses
Spanning tree Algorithm for data transmission so as
to avoid loops in the network.
 IPv4 - 32 bits
 IPv6 - 128 bits

Networking Devices

 Modem:
Modem
stands
for
ModulatorDemodulator. It is used to connect computers for
communication via telephone lines.
 Hub: It works at the Physical layer. It just acts like
a connector of several computers i.e. simply
connects all the devices on its ports together. It
broadcasts all the data packets arriving at it with no
filtering capacity.
 Switch: It works at the Data Link Layer. It is used
for dividing a network into segments called subnets.
It provides filtering of data packets and prevents
network traffic also.
 Repeater: It operates at thePhysical Layer. It is
used to amplify a signal that has lost its original
strength so as to enable them to travel long
distances. It can only join the networks that
transmit similar data packets. It does not have
filtering capacity i.e. all data including noise is
amplified and passed on in the network so don’t
help in reducing network traffic.
 Router: It works at the Network Layer and is used
to connect different networks that have different
architectures and protocols. It sends the data
packets to desired destination by choosing the best
path available thus reducing network traffic. It
routes the data packets using the routing table that
contains all the Information regarding all known
network addresses, possible paths and cost of
transmission over them. Availability of path and
cost of transmission decide sending of data over
that path. It is of 2 types: static (manual
configuration of routing table is needed) and
dynamic (automatically discovers paths).
 Gateway: It operates in all the layers of the
network architecture. It can be used to connect
two
different
networks
having
different
architectures, environment and even models. It
converts the data packets in form that is suitable to
the destination application. The two different
networks may differ in types of communication
protocols they use, language, data formats etc.
 Bridge: They are used two connect two LANs with
the same standard but using different types of
cables. It provides an intelligent connection by
allowing only desired messages to cross the
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INFORMATION SECURITY
 A Computer Virus is a computer program or code
that can replicate itself and spread from one
computer system to another system. A computer
virus has the capacity to corrupt or to delete data on
your computer and it can utilize an e-mail program
to spread the virus to other computer systems. In
the worst case scenario, it can even delete
everything on your hard disk. The purpose of it is to
disrupt the operation of the computer or the
program.
 Some examples of Computer Virus are Trojan
viruses. stealth viruses, worms, malware
(malicious software), Disk Killer, Stone virus,
Sunday, Cascade, Nuclear, Word Concept, etc.
 Malware, short for malicious software, is any
software used to disrupt computer operation,
gather sensitive information, or gain access to
private computer systems. It can appear in the form
of executable code, scripts, active content, and other
software.
 Antivirus Software is used to scan the hard disk to
remove the virus from them. Some of the famous
anti – viruses available are Avast!, Norton, Avira,
Kaspersky, AVG, etc.
 A person who uses his or her expertise to gain
access to other people’s computers to get
information illegally or do damage is a Hacker.
 Authorization is the function of specifying access
rights to resources related to information security
and computer security in general and to access
control in particular. More formally, "to authorize"
is to define an access policy.
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 Authentication is the act of confirming the truth of
an attribute of a single piece of data or entity. It
might involve confirming the identity of a person by
validating their identity documents, verifying the
validity of a website with a digital certificate,
tracing the age of an artifact by carbon dating, or
ensuring that a product is what its packaging and
labelling claim to be. In other words, Authentication
often involves verifying the validity of at least one
form of identification.
 Phishing is the attempt to acquire sensitive
information such as usernames, passwords, and
credit card details (and sometimes, indirectly,
money) by masquerading as a trustworthy entity in
an electronic communication.
 A Spoofing attack is a situation in which one
person or program successfully represents oneself
as another by falsifying data and thereby gaining an
illegitimate advantage.
 The Open Systems Interconnection model (OSI)
is a conceptual model that characterizes and
standardizes the internal functions of a
communication system by partitioning it into
abstraction layers. The model is a product of the
Open Systems Interconnection project at the
International Organization for Standardization
(ISO).
Seven layers of OSI Model are:
 Application Layer
 Presentation Layer
 Session Layer
 Transport Layer
 Network Layer
 Data link Layer
 Physical Layer
 Network topology is the arrangement of the
various elements (links, nodes, etc.) of a computer
network.There are two basic categories of network
topologies:

Physical topologies and logical topologies.
Physical topology is the placement of the various
components of a network, including device
location and cable installation, while logical
topology illustrates how data flows within a
network, regardless of its physical design. Various
types of topologies are:
 Bus Topology
 Star Topology
 Ring Topology
 Mesh Topology
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Tree Topology
Hybrid Topology
LOGIC GATES
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A logic gate is an elementary building block of a
digital circuit. Most logic gates have two inputs
and one output. At any given moment, every
terminal is in one of the two binary conditions
low (0) or high (1)
There are seven basic logic gates:
 AND
 OR
 XOR
 NOT
 NAND
 NOR
 XNOR
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DATABASE MANAGEMENT SYSTEM
 DBMS is the acronym of Data Base Management
System. DBMS is a collection of interrelated data
and a set of programs to access this data in a
convenient and efficient way. It controls the
organization, storage, retrieval, security and
integrity of data in a database.
 Architecture
of
DBMS-The
generalized
architecture of DBMS is called ANSI/ SPARC model.
The architecture is divided into three levels:
 External view or user view/View Level- It is the
highest level of data abstraction. This includes only
those portions of database of concern to a user or
Application program. Each user has a different
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external view and it is described by means of a
scheme called external schema.
 Conceptual view/Logical Level- All the database
entities and the relationship among them are
included. One conceptual view represents the entire
database called conceptual schema.
 Internal view/Physical Level- It is the lowest level
of abstraction, closest to the physical storage
method. It describes how the data is stored, what is
the structure of data storage and the method of
accessing these data. It is represented by internal
schema.
 Data model:A data model is a plan for building a
database. The model represents data conceptually,
the way the user sees it, rather than how computers
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store it. Data models focus on required data
elements and associations.
 Entity – Relationship Model
 Relational Model
 Entity:A thing (animate or inanimate) of
independent physical or conceptual existence and
distinguishable. In the University database context,
an individual student, faculty member, a class room,
a course are entities.
 Attributes
 Each entity is described by a set of
attributes/properties.
Types of Attributes

Simple Attributes: having atomic or
indivisible values: Dept – a string Phone
Number – an eight digit number.

Composite Attributes: having several
components
in
the
value.
Example:
Qualification with components (Degree Name,
Year, University Name)

Derived Attributes: Attribute value is
dependent on some other attribute. Example:
Age depends on Date of Birth. So age is a
derived attribute.

Single-valued: having only one value rather
than a set of values. For instance, Place of
Birth-single string value.

Multi-valued: having a set of values rather
than a single value, for instance, Courses
Enrolled attribute for student Email Address
attribute for student Previous Degree attribute
for student. Attributes can be: simple singlevalued, simple multi-valued, composite singlevalued or composite multi-valued.

FULL FORMS & ABBREVIATIONS
TCP
FTP
TFTP
SFTP
SMTP
HTTP
HTTPS
UDP
ARP
Tel Net
POP3
BGP
P2P

Transmission Control Protocol
File Transfer Protocol
Trivial File Transfer Protocol
Secure File Transfer Protocol
Simple Mail Transfer Protocol
Hyper Text Transfer Protocol
Hyper Text Transfer Protocol Secure
User Datagram Protocol
Address Resolution Protocol
Telecommunication Networking
Post Office Protocol Version3
Border Gateway Protocol
Point to Point Protocol
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PPP
Peer to Peer Protocol
IP
Internet Protocol
SNMP
Simple Network Management Protocol
NTP
Network Time Protocol
SIP
Session Initiation Protocol
DHCP
Dynamic Host Configuration Protocol
VOIP
Voice Are Internet Protocol
IMAP4
Internet Message Access Protocol
Version 4
RARP
Reverse Address Resolution Protocol
SSH
Secure Shell
MIME
Multipurpose Internet Mail Extension
SMIME
Secure Mime
ALGOL
Algorithmic Language
ANSI
American National Standard Institute
ATM
Asynchronous Transfer Mode
AS
Autonomous System
BASIC
Beginners All Purpose Symbolic
Instruction Code
BIOS
Basic input Output System
BPS
Bit Per Second
DNS
Domain Name Server
EDI
Electronic Data Interchange
URL
Uniform Resource Locator
GIF
Graphics Interchange Format
ASCII
American Standard Code for
Information Interchange
ASP
Active Sever Pages
BCC
Blind Carbon Copy
CAD
Computer Aided Design
CDMA
Code Durian Multiple Access
GSM
Global
System
for
Mobile
Communication
CMOS
Complementary Metal Oxide Semi
Conductor
CMYK
Cyan Magenta Yellow Block
GPS
Global Positioning System
GUI
Graphical User Interface
HDMI
High Definition Multimedia Interface
GIGO
Garbage in Garbage Out
LIFO
Last In First Out
FIFO
First In First Out
PING
Pocket Internet Gopher
HDD
Hard Disc Drive
NIC
Network Interface Controller/Cord
HDTV
High Definition Television
ISP
Internet Service Provider
JPEG
Joint Picture Expert Group
LCD
Liquid Crystal Display
LED
Light Emitting Diode
TFT
Thin Film Transistor
CRT
Cathode Ray Tube
MIDI
Musical Instrument Digital Interface
MPEG
Moving Picture Expert Group
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PDA
PDF
SQL
USB
VIRUS
VOIP
IVR
WIFI
WIMAX

Personal Digital Assistants
Portable Document Format
Structured Query Language
Universal Serial Bus
Vital Information Resource Under Sieze
Voice Over Internet Protocol
Interactive Voice Response
Wireless fidelity
Worldwide Interoperability for
Microwave Access
ADSL
Asymmetric Digital Subscriber Line
API
Application Program Interface
ARP
Address Resolution Protocol
RARP
Reverse ARP
ICANN
Internet Corporation of Assign Names
& Numbers
DPI
Data Per Inch
DSL
Digital Subscriber Line
FAT
File Allocation Table
MANET
Mobile Ad-Hoc Network
MIPS
Million Instruction Per Second
BIPS
Billion Instruction Per Second
TIPS
Trillion Instruction Per Second
NAT
Network Address Translation
IEEE
Institute of Electrical and Electronic
Engineer
IMAP
Internet Message Access Protocol
ISDN
Integrated Servers Digital Network
ISO
International
Standard
Organization/International Org for Standardization
DHTML
Dynamic Hyper Text Markup Language
MAC
Media Access Control
CAN
Campus Area Network
PAN
Personal Area Network
SAN
Storage Area Network
CNM
Calculatory Network Mode
IPV4
Internet Protocol Version 4
IPV6
Internet Protocol Version 6
DBMS
Data Base Management System
MODEN
Modulator Demodulator
RAM
Random Access Memory
ROM
Read Only Memory
SMPS
Switch Mode Power Supply
OMR
Optical Mark Reader / Recognition
OCR
Optical Character Reader / Recognition
BCR
Bar Code Reader
MICR
Magnetic Ink Character Reader /
Recognition
PCB
Printer Circuit Board
SRAM
Static Ram
DRAM
Dynamic Ram
PROM
Programmable Rom
EPROM
Electrically Prom
EEPROM
Electrically Erasable Prom
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HDD
FDD
CD
DVD
BRD
HVD
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Hard Disc Drive
Floppy Disc Drive
Compact Disc
Digital Video/Versatile Disc
Blue Ray Disc
Holographic Versatile Disc

GLOSSARY
A
Access time - The amount of time it takes for
requested information to be delivered from disks
and memory.
Antivirus software - A program designed to look
for and destroy viruses that may infect the memory
of a computer or ﬁles stored on a computer.
Artiﬁcial intelligence (AI) - Computer systems
that attempt to imitate human processes for
analyzing and solving problems.
Accumulator - A local storage area called a
Register, in which the result of an arithmetic or
logic operation is formed.
B
BIT - It is basic unit of computers. It has two values
1 & 0 only.
BYTE - Combination of 8 Bits.
Basic Input Output System (BIOS) - Also known
as ROM BIOS. It provides a abstraction layer for the
hardware, i.e., a consistent way for application
programs and operating system to interact with
input/output devices.
Bug - A software bug is an error, flaw, failure, or
fault in a computer program or system produces an
incorrect or unexpected result.
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Bus - A pathway along which electronic signals
travel between the components of a computer
system.
C
Cookie - A packet of information that travels
between a browser and the web server.
Crash - Your computer or application no longer
works correctly and so you “loose” all the work
you’ve done since the last time you saved.
Command - An instruction that causes a program
or computer to perform a function.
Cache - It is a memory storage area that keeps
frequent use data readily available to the computer
so that the computer does not retrieve them from
slow storage devices.
Clock Speed - The speed of computer is measured
in clock speed. High clock speed is synonymous
with high processing capability. It is measured in
Megahertz (MHz).
Column - A vertical block of cells in a table or
spreadsheet.
D
Delete - To remove an item of data from a file or to
remove a file from the disk.
Debugging - Locating and eliminating defects in a
program.
Desktop - The electronic work area on a display
screen.
Dots Per Inch (DPI) - It is defined as the measure
of the resolution of a printer and scanner, or
monitor.
Domain Name - A unique name that identifies a
particular website and represents the name of the
server where the web pages reside.
E
Edit - To make certain changes in existing data.
Ethernet Card - A network adapter that enables a
computer to connect to an ethernet.
F
Fax - A shortened form of the word facsimile. A
copy of a document transmitted electronically from
one machine to another.
File transfer protocol (FTP) - A set of guidelines
or standards that establish the format in which ﬁles
can be transmitted from one computer to another.
Firewall - A security system usually consisting of
hardware and software that prevents unauthorized
persons from accessing certain parts of a program,
database, or network.
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Flash Memory - It is a type of non-volatile
computer storage chip that can be electrically
erased and reprogrammed. It was developed by
EEPROM.
G
Gateway - A machine that links two networks using
different protocols.
Gigabyte - A measurement of the storage capacity
of a device. One gigabyte represents 1024
megabytes.
Google – search engine on the web.
Gopher - A protocol used for locating and
transferring information on the internet. It is an
internet search tool that allows users to access
textual information.
GUI - Graphical User Interface uses icons and
menus to carry out commands such as opening files,
delete files, move files etc..
Graphic Interchange Format (GIF) - A simple file
format for pictures and photographs, that are
compressed so that they can be sent quickly.
H
Hard copy - Text or graphics printed on paper; also
called a printout.
Hard disk - A rigid type of magnetic medium that
can store large amounts of information.
Hyperlink - An image or portion of text on a
webpage which is linked to another webpage.
Hub - A network device that connects multiple
computers on a LAN so that they can communicate
with another network and the internet.
Header - Repetitive information that appears at the
top (the head) of every page of a document.
Hypertext transfer protocol (HTTP) - The
protocol used on the World Wide Web that permits
Web clients (Web browsers) to communicate with
Web servers
I
Icons - In a graphical user interface (GUI), a small,
pictorial, on screen representation of an object, such
as a document, program, folder or disk drive.
Instant messaging (IM) - A chat program that lets
people communicate over the Internet in real time.
Internet protocol (IP) address - A unique set of
numbers that identiﬁes a computer over a network.
Internet service provider (ISP) - An organization
that provides access to the Internet for a fee.
Intranet - A private network established by an
organization for the exclusive use of its employees.
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Firewalls prevent outsiders from gaining access
to an organization’s intranet
J
JPEG - Joint Photographic Experts Group. A format
for storing complex graphics in compressed form.
Justiﬁcation - Aligning lines of text at the left
margin, the right margin, both margins, or the
centre. Text aligned at both margins is considered
fully justiﬁed.
K
Keyboard - The device used to enter information
into a computer.
Kilobyte - A measurement of the storage capacity of
a device. One kilobyte represents 1024 bytes.
L
LAN - A local area network (LAN) is a computer
network that interconnects computers within a
limited area such as a home, school, computer
laboratory, or office building, using network media.
Laptop computer - A portable computer. Also
known as a notebook computer.
Landscape Orientation – The positioning of the
page so that the information is printed across the
long dimension of the page.
Liveware - It is a term to describe the human
system, opposed to hardware or software in a
computer.
























M
Macro virus - A type of virus that attaches itself to
documents or word processing templates.
Malware - Software that disrupts normal computer
functions or sends a user’s personal data without
the user’s authorization.
Memory - The part of a computer that stores
information.
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Memory Cell - A circuit in memory that represents
a single bit of information.
Mass Storage - Storage systems that provide access
to hundreds of billions of bytes of stored data. They
are often referred to as Archival Storage because of
the very large volumes of historical or backup data
they can store.
MIPS - An acronym derived from millions of
instructions per second. Used to measure the speed
of a processor.
Morphing - The transformation of one image into
another image.
Mobile Commerce (m-Commerce) - A form of ecommerce that has the ability to conduct monetary
transactions via a mobile device such as a cell
phone.
Mozilla - a web browser and successor to Netscape
Communicator.
Multitasking - The ability of a computer to execute
more than one program at a time.
N
NIBBLE - Combination of four bits.
Network - A system of interconnected computers.
They are of three types i. e. LAN, MAN, WAN.
Network Interface Card (NIC) - This is a part of
the computer that allows it to talk to other
computers via a network protocol like TCP/IP.
Node - A computer which is attached to the
network. Each node has its own address on the
network so that it can be uniquely identified and
can communicate with other nodes on the same or
different network.
O
Ofﬂine - Refers to the state in which a computer is
temporarily or permanently unable to communicate
with another computer.
Online - Refers to the state in which a computer is
ready to communicate with other computers.
Open source software - Software that makes the
underlying source code available to all users at no
charge.
Operating system (OS) - Software that manages
the internal functions and controls the operations of
a computer.
P
Palmtop computer - A portable computer smaller
than a notebook (or laptop) computer that ﬁts on
the palm of your hand. Also called a handheld
computer.
Password - A user’s secret identiﬁcation code,
required to access stored material. A procedure
intended to prevent information from being
accessed by unauthorized persons.
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Piracy - The illegal copying of software or other
creative works.
Peripherals - A connectable device that has an
auxiliary function outside the permanent system
configuration such as plotters, printers and graphic
displays.
Phishing - A type of computer fraud that tries to
trick users into revealing their passwords and other
conﬁdential information.
Pixel - A smallest picture element of a digital image.
The smaller the pixels, the higher the resolution.
Port - An electrical connection on the computer into
which a cable can be plugged so that the computer
can communicate with other devices such as printer
or modem.
Protocol - A set of rules and regulations that
coordinates the exchange of information over the
network.
Portrait orientation - Positioning paper so that
information is printed across the short dimension of
the paper.
Q
Query - An alternate pipe form of operating system,
which handles data in the form of messages rather
than bytes.
Qwerty - It is one of the standard computer
keyboard, with the character Q, W, E, R, T, Y on the
top row of letters on the keyboard.
R
Response time - The time a computer takes to
execute a command.
Retrieve - To call up information from memory or
storage so that it can be processed in some way.
Record - A collection of all the information
pertaining to a particular subject.
Row - A horizontal block of cells in a table or
spreadsheet.
Resolution - Measurement of the degree of
sharpness of a displayed image. It is defined as
number of pixels per square inch on a computer
generated display.
Register - A temporary storage unit for quick,
direct accessibility of a small amount of data for
processing.
S
Save As – Give the file a name and/or store the file
in a certain place.
Save - Tell the computer to create a file on disk that
has the information you’ve put into the document.
Scroll bar - Allows you to move around through
your document.
Shut down - To quit all applications and turn off the
computer.

www.bankersadda.com

|























www.careerpower.in

Spam - unwanted repetitious messages, such as
unsolicited bulk e-mail.
Scanner - An input device that can copy a printed
page into a computer’s memory, thus doing away
with the need to type the copy.
Screen saver - A program that changes the screen
display while the user is away from the computer.
Server - A computer that manages a shared
resource and provides a set of shared user services
to the clients.
Search Engine - Software that searches, gathers
and identifies information from a database based on
an index, keywords or titles.
Spam - Unwanted repetitious messages, such as
unsolicited bulk e-mail.
Soft copy - Information shown on the display
screen.
Sort - To arrange ﬁelds, records, or ﬁles in a
predetermined sequence.
Surﬁng the Net - Browsing through various Web
sites on the Internet in search of interesting things.
T
Trash - Place where you put files and folders that
you want to delete or get rid of.
Topology - The structure of the network, including
physical connections such as wiring schemes and
logical interactions between network devices.
Track - A ring on a disk where data can be written.
Telnet - A protocol for remote computing on the
internet that allows a computer to act as a remote
terminal on another machine, anywhere on the
internet.
Touchpad - The device on a laptop computer that
takes the place of a mouse.
Touch screen technology - The technology that
permits a user to perform a function simply by
touching the screen on an appropriate spot.

U
Uninterrupted Power Supply (UPS) - A Battery
powered backup system that provides enough
electricity to a computer during a power outage so
that a user can save files before shutting down the
computer.
Universal Serial Bus (USB) - A common standard
for connecting multiple peripherals to a computer
as needed.
Upload - To transfer information from a client
computer to a host computer.
V
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Virus - A piece of computer code designed as a
prank or malicious act to spread from one computer
to another by attaching itself to other programs.
W
WAP - Wireless Application Protocol is a
specification for a set of communication protocol
used to allow wireless devices to access the internet
and other utilities.
Web browser - Software that permits a user with a
click of a mouse to locate, display, and download
text, video, audio, and graphics stored in a host
computer on the Web.
The most common Web browsers now in use are
Internet Explorer, Google Chrome and Mozilla
Firefox.
Web site - One or more related pages created by an
individual or an organization and posted on the
World Wide Web.
Wi-Fi (Wireless ﬁdelity) - A process that permits
high-speed wireless transmission of data.
Word processing - The electronic process of
creating, formatting, editing, proofreading, and
printing documents.
Workstation - A desktop computer that runs
applications and serves as an access point in a local
area network.
Z
Zombie - A computer that has been hijacked by a
cracker without the owner’s knowledge and used to
perform malicious tasks on the Internet.







OS X Yosemite is the latest version of the Apple Mac
Operating System (Next will be OS X El Capitan)
List of some famous E-Commerce Website :
Paytm (India's Largest mobile commerce platform.
Paytm is an Indian e-commerce shopping website
launched in 2010)
 Amazon
 Alibaba
 Flipkart
 Snapdeal
 HomeShop18
 Myntra
 Jabong
List of companies recently got the payment bank
License
 Tech Mahindra Ltd
 Vodafone m-pesa Ltd
 Reliance Industries Ltd
 Fino PayTech Ltd
 National Securities Depository Ltd
 Aditya Birla Nuvo Ltd
 Airtel M Commerce Services Ltd

Miscellaneous
Blackberry 10 OS is the latest version of OS
available for blackberry devices.
Windows 10: Windows 10 launched globally on
29th July. This is the latest version of windows
available for computers. It is yet to be released for
Mobile.
ANDROID 6.0 MARSHMALLOW : Latest version of
the android software released
Google Nexus 6 will be manufactured by Huawei
Microsoft has officially released a beta version of its
Cortana app for Android for anyone to download
and install. Cortana has the ability to replace Google
Now when the users press the Android home button
on a handset. Windows versions of Cortana support
the ‘Hey Cortana’ voice feature.
iOS 8 is the latest version of the Apple phones
Operating System (Next will be iOS 9)

BankersAdda wishes you all a very Best of Luck..!!
www.bankersadda.com
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